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Introduction 

Paragon Partition Manager™ 11 Free is an integrated set of powerful tools that is specially designed to tackle most of 

the problems you might face while using PC. A highly intelligent program engine together with built-in advanced 

recovery facilities make it possible to securely carry out partitioning operations of any complexity, optimize 

performance of NTFS and FAT file systems, migrate the system to another hard disk, etc. without fear to lose precious 

data. 

In this manual you will find the answers to many of the technical questions, which might arise while using the program. 

 

 

Our company is constantly releasing new versions and updates to its software, that's why 

images shown in this manual may be different from what you see on your screen. 

 

What’s New in Partition Manager 11 

 Automatic partition alignment during partitioning/copy operations to optimize performance of your hard disk. 

 Check FS Integrity and Data Loss Policies to let you specify the acceptable balance between the operation 

performance and the risk of data loss. 

 AFD (Advanced Format Drive) ready. 

 Support of 2TB+ and non-512B sector size drives. 

 USB 3.0 ready. 

Features Overview 

This chapter dwells upon key benefits and technical highlights of the product. 

Features  

Let us list some of the features: 

User Friendly Fault Minimizing Interface 

 Graphical representation of the data to gain a better understanding. 

 A handy Launcher to easily find and run the required tasks. 

 Comprehensive wizards to simplify even the most complex operations. 

 A context sensitive hint system for all functions of the program.  

 Previewing the resulting layout of hard disks before actually executing operations (so-called virtual 

operations). 

Copy Facilities 

 Partition copy to successfully transfer all on-disk information including standard bootstrap code and other 

system service structures, thus maintaining the operating system’s working capability. 
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Copy functionality can also be used as an alternative way of data protection. 

 

Partition/Hard Disk Management Facilities 

 Basic functions for initializing, partitioning and formatting hard disks (create, format, delete). Instead of the 

standard Windows disk tools, the program supports all popular file systems. 

 Express Create Partition Wizard to create a new partition in the most appropriate place of a hard disk, format it 

to NTFS and then make it available in the system by assigning a drive letter. 

 Express Resize Partitions Wizard to increase free space on one partition by up-taking the unused space of an 

adjacent partition of a hard disk (including partitions of Apple Boot Camp). 

 NTFS hot resize upward to enlarge an NTFS partition (system, locked) without rebooting Windows and 

interrupting its work. 

 Convert a file system (FAT16/32, NTFS, Ext2/Ext3) without reformatting. 

 Mount a partition (assign a drive letter) of any file system type to make it available for your operating system. 

 Modify file system parameters (make active/inactive, hide/unhide, etc.). 

File System Optimization Facilities 

 27 defragmentation strategies available to defragment FAT and NTFS file systems. 

 Safe Defragmentation Mode to guarantee data loss free defragmentation of any version of NTFS and FAT. 

 Low free space defragmentation (less than 1% of the free space required) to successfully defragment almost full 

disks. 

Supported Technologies 

Along with using innovative technologies from outside, Paragon has developed a number of its own original 

technologies that make its products unique and attractive for customers: 

 Paragon Hot Copy™ technology to copy locked partitions and hard disks under Windows NT+ family operating 

systems providing both high operating efficiency as well as low hardware requirements. 

 Paragon Power Shield™ technology to provide data consistency in case of a hardware malfunction, power 

outages or an operating system failure. 

 Paragon UFSD™ technology to browse partitions of any file system including hidden and unmounted, modify 

and copy files and folders, etc. 

 Paragon Hot Resize™ technology to enlarge NTFS partitions (system, locked) without rebooting Windows and 

interrupting its work. 

 Paragon Smart Partition™ technology to securely perform hard disk partitioning operations of any complexity. 

 Paragon BTE™ technology to set tasks for execution during the system restart, thus saving from the need to use 

a bootable media when modifying system partitions. 

 Microsoft Volume Shadow Copy Service (VSS) to provide the copy/backup infrastructure for the Microsoft 

Windows XP/Vista/7/Server 2003/2008 operating systems. It offers a reliable mechanism to create consistent 

point-in-time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the 

leading copy/backup solution vendors on the market, it is based on a snapshot technology concept. 
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 GUID Partition Table (GPT). It is the next generation of a hard disk partitioning scheme developed to lift 

restrictions of the old MBR. GPT disks are now supported by Windows Vista/7, Server 2008, Mac OS X and Linux. 

Supported File Systems 

 Full read/write access to FAT16/FAT32 partitions. 

 Full read/write access to NTFS (Basic Disks) under Windows, Linux and PTS DOS. Compressed NTFS files are also 

supported. 

 Full read/write access to Ext2FS/Ext3FS/Ext4FS partitions. 

 Limited read/write access to Apple HFS+ partitions. 

 

 

Unfortunately, support of non-Roman characters for the HFS+ file system is unavailable at 

the moment. The company is about to implement it in the nearest future. 

 

Supported Media 

 Support of both MBR and GPT hard disks (2.2TB+ disks included) 

 IDE, SCSI and SATA hard disks 

 SSD (Solid State Drive) 

 AFD (Advanced Format Drive) 

 Non-512B sector size drives 

 CD-R, CD-RW, DVD-R, DVD+R, DVD-RW, DVD+RW, DVD-R, DVD+R double layer and also Blu-ray discs 

 FireWire (i.e. IEEE1394), USB 1.0, USB 2.0, USB 3.0 hard disks 

 PC card storage devices (MBR and GPT flash memory, etc.) 

Getting Started 

In this chapter you will find all the information necessary to get the product ready to use. 

Contacting Paragon Software GmbH 

If you have any questions about the company products, please do not hesitate to contact Paragon Software GmbH. 

Service Contact 

Visit Paragon Software web site www.paragon-software.com 

Registration & updates web-service www.paragon-software.com/support 

Knowledge Base & Technical Support kb.paragon-software.com 

Pre-sale information sales@paragon-software.com 

 

http://www.paragon-software.com/
https://www.paragon-software.com/support/index.html
http://kb.paragon-software.com/
sales@paragon-software.com


8 

Copyright© 1994-2011 Paragon Software Group. All rights reserved. 

System Requirements 

 Operating systems: 

- Windows 2000 (32 bit only) 

- Windows XP (32 and 64 bit) 

- Windows Vista (32 and 64 bit) 

- Windows 7 (32 and 64 bit) 

 Internet Explorer 5.0 or higher  

 Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed  

 128 MB of RAM (256+ recommended) 

 Hard disk drive with 250 MB of available space  

 SVGA video adapter and monitor  

 Keyboard 

 Mouse 

 

 
During the installation additional free space (up to 1GB) will be required. 

Installation 

To install Paragon Partition Manager 11, please do the following: 

1. Run Setup Application. Click on the *.MSI file. This application will guide you through the process of the 

program installation. The setup utility is compiled with the InstallShield SDK, hence it contains the standard user 

interface and set of installation steps. 

 

 

In case there is some previous version of the program installed on the computer, the 

program will offer the user to uninstall it first. 

 

2. Starting Setup. The Welcome page informs that the application is being installed. Click the Next button to 

continue. 

3. Confirm License Agreement. The License Agreement page displays the Paragon License Agreement. Read the 

agreement and then select the appropriate option to accept. If you do not agree with any conditions stated 

there, the installation process will be interrupted. By clicking the Print button, the License Agreement may also 

be printed out. 

4. Provide Registration Information. On the Registration page you are to provide your product key and serial 

number. 

5. Provide Customer Information. On the Customer Information page you are to provide the standard 

information, i.e. a user name and an organization. Besides you need to decide whether to make the program 

available for all users of this computer (if several) or only for the current one. 
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6. Select an Installation Folder. The Destination Folder page allows you to choose a folder where the program will 

be installed. By default, the installation folder will be created as: 

C:\Program Files\Paragon\Paragon Partition Manager 11. To select another folder, click the Change… button. 

After you have selected the required folder, click the Next button to continue. 

 

 

Do not install the program on network drives. Do not use Terminal Server sessions to install 

and run the program. In both cases, the program functionality will be limited. 

 

7. Confirm Installation. On the Ready to Install the Program page click the Install button to start the installation or 

the Back button to return to any of the previous pages and modify the installation settings. 

8. Copying Files. The Copying Files page shows the overall progress of the installation. Click the Cancel button to 

abort the setup. 

9. Finishing the Installation. The Final page reports the end of the setup process. Click the Finish button to 

complete the wizard. 

 

 

To accomplish online operation on locked partitions/hard disks the program uses a kernel 

mode hotcore driver, thus the system reboot is required to complete the installation 

procedure. 

 

First Start 

To start Paragon Partition Manager 11 under Windows, please click the Windows Start button and then select Programs 

> Paragon Partition Manager™ 11 > Paragon Partition Manager™. 

 

 

The program provides wide opportunities in the field of hard disk structure modification, so 

just to be on the safe side, please make a backup of your data before carrying out any 

operation. 

 

The first component that will be displayed is called the Express Launcher. Thanks to a well thought-out categorization 

and hint system, it provides quick and easy access to wizards and utilities that we consider worth using on a regular 

basis. With its help you can also start up the traditional launcher, the help system or go to the program’s home page. 
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To know more on how to handle the product’s interface and accomplish typical operations, 

please consult the Windows Components chapter. 

 

Basic Concepts  

This chapter explains terms and ideas that show how the program works. To understand these helps to obtain a general 

notion of the operation performance and makes it easier for the user to operate the program. 

GPT versus MBR 

GUID Partition Table (GPT) is the next generation of a hard disk partitioning scheme developed to lift restrictions of the 

old MBR. Being a part of the Extensible Firmware Interface (EFI) standard proposed by Intel to replace the outdated PC 

BIOS, it offers a number of crucial benefits: 

 Up to 128 primary partitions for the Windows implementation (only 4 in MBR); 

 The maximum allowed partition size is 18 exabytes (only 2 terabytes in MBR); 

 More reliable thanks to replication and cyclic redundancy check (CRC) protection of the partition table; 

 A well defined and fully self-identifying partition format (data critical to the platform operation is located in 

partitions, but not in un-partitioned or hidden sectors as this is the case with MBR) 

To tackle compatibility problems with older operating systems there has been introduced a special combined GPT+MBR 

partitioning scheme called Retained GPT (also known as Hybrid GPT), where the first three partitions except for EFI (GPT 

service partition) are synced between GPT and MBR. This synced partition map provides an avenue, for instance for 
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booting 32-bit Windows Vista/7 on computers controlled by the old BIOS. It’s also used for dual booting Mac OS X and 

Windows on a GPT disk. 

Apple Boot Camp 

Boot Camp is a special utility to help you set up a dual boot system (Mac OS X and 32-bit Windows XP/Vista) on Intel-

based Macs. It enables to securely re-partition your hard disk (resize an existing HFS+ partition to create a separate 

partition for Windows) and then launch the installation process. With Boot Camp all the necessary drivers will be at your 

disposal. Moreover after Windows has been installed it will serve as a boot manager to choose what operating system 

to start up. 

 

 

It is strongly recommended not to modify the hard disk configuration with Windows Disk 

Manager. Otherwise it may lead to unexpected consequences, right up to BSOD and 

inability to boot in Windows XP/Vista. Please use our program to correctly update both 

MBR and GPT. 

 

64-bit Support 

The bulk of software today is written for a 32-bit processor. It can meet the requirements of almost any end user. 

However that is not the case when dealing with servers processing large amounts of data with complex calculations of 

very large numbers. That is where 64-bit architecture comes into play.  

It can boast improved scalability for business applications that enables to support more customer databases and more 

simultaneous users on each server. Besides a 64-bit kernel can access more system resources, such as memory 

allocation per user. A 64-bit processor can handle over 4 billion times more memory addresses than a 32-bit processor. 

With these resources, even a very large database can be cached in memory.  

Although many business applications run without problems on 32-bit systems, others have grown so complex that they 

use up the 4 GB memory limitation of a 32-bit address space. With this large amount of data, fewer memory resources 

are available to meet memory needs. On a 64-bit server, most queries are able to perform in the buffers available to the 

database. 

Some 32-bit applications make the transition to the 64-bit environment seamlessly others do not. For instance, system-

level utilities and programs that provide direct hardware access are likely to fail. Our program offers a full-fledged 

support of the 64-bit architecture providing fault-tolerant work for such system dependent modules as Hot Processing. 

Copy Operations 

Hard drive duplication nowadays is becoming highly popular among PC users. That is due to some definite advantages it 

can offer. First of all, many people clone hard disks just to back up data for security reasons. The present day copy 

utilities enable to successfully transfer all on-disk information including standard bootstrap code and other system 

service structures, thus maintaining the operating system’s working capability. In case of a system malfunction, the user 

can get the system back on track in minutes. No additional configuration is required, what is very convenient. 

The second possible application is the upgrade of a hard disk to a new one. The capacity of a modern hard drive doubles 

every two years, thus opening up new possibilities for software developers. As a result programs become more 

complicated and require considerable amount of free space. One day the user realizes that there is no more free space 

left on the hard disk and the only way out is to upgrade. Usually that means that besides purchasing a new hard disk, 

the user is to face a large re-installation procedure spanning several days of tedious work. But all of this can be avoided 

just by copying the contents of the old hard disk to a new one proportionally resizing the partitions. 
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And the last but not least is the copying of hard disks for cloning purposes. It may be of great use when setting up 

similar computers. There is no need for a system administrator to install an operating system from scratch on every one 

of them. It is enough just to configure one and then clone it to the others. 

Drive Partitioning 

As you probably know a hard drive is to be split into one or more partitions, since it cannot hold data until it is carved up 

and space is set aside for an operating system. Until recently most PCs used to have just one partition, which filled the 

entire hard disk and contained an OS. The situation has changed however, thanks to new cost-effective high capacity 

hard drives, thus opening up numerous possibilities for PC users, such as editing video, archiving music, backing up CD 

images, etc. Huge increase in space is great, but it poses a number of problems, most important of which are effective 

data organization and speed. 

Large drives are always going to take longer to search than smaller volumes, and an operating system is going to have its 

work cut out both finding and organizing files. It is for this reason that many people decide to invest in multiple hard 

drives, but there is an easy solution – drive partitioning. Partitioning lets you divide a single physical drive into a number 

of logical drives, each of which servers as a container with its own drive letter and volume label, thus enabling the 

operating system to process data more efficiently. Besides partitioning makes it possible to organize data so that it is 

easy to find and manage. You can set aside, for instance, 40 GB of a 160 GB hard drive for the OS, 70 GB for storing 

video and another 50 GB for your favorite music collections to provide transparent data storage. 

It is also worth mentioning to that with a hard drive properly partitioned, such routine operations as files de-

fragmentation or consistency check will not be that annoying and time-consuming any more. 

By detaching the OS from the rest of the data you can tackle one more crucial issue – in case of a system malfunction, 

you can get the system back on track in minutes by recovering it from a backup image located on the other partition of 

the hard drive. 

But that is not all drive partitioning may be used for. If you are willing to play games in Windows while browsing the 

Internet in Linux, 100-percent sure that no virus will attack your PC, drive partitioning is a necessity. In order to run 

several OSs on a single hard drive you are to create a corresponding number of partitions to effectively delineate the 

boundaries of each OS. 

Windows Components 

In the given section you can find all the information necessary to successfully work with the Windows version of the 

product. 

Interface Overview 

This chapter introduces the graphical interface of the program. The design of the interface precludes any mistake being 

made on the part of the user. Most operations are performed through the system of wizards. Buttons and menus are 

accompanied by easy understandable icons. Nevertheless, any problems that might occur while managing the program 

can be tackled by reading this very chapter. 

General Layout 

When you start the program, the first component that is displayed is called the Launcher. It enables to run wizards and 

dialogs, to specify program settings, to visualize the operating environment and the hard disk configuration. 

The Launcher’s window can be conditionally subdivided into several sections that differ in their purpose and 

functionality: 



13 

Copyright© 1994-2011 Paragon Software Group. All rights reserved. 

 

1. Main Menu  

2. Tool Bar  

3. Virtual Operations Bar  

4. Common Tasks Bar  

5. Explorer Bar  

6. Disk Map  

7. Partition List 

8. Properties Bar 

9. Legend Bar 

10. Status Bar 

A number of panels offer similar functionality with a synchronized layout. The program enables to conceal some of them 

to simplify the interface management. 

All panels are separated by vertical and horizontal expandable sliders, allowing the user to customize the screen layout. 

Main Menu 

The Main Menu provides access to the entire functionality of the program. The available functions are as listed below: 

MENU ITEM FUNCTIONALITY 

Tools 
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View Log Files View logs on the carried out operations 

Settings... Edit the general settings of the program  

Exit Exit the program 

Changes 

Undo `the last virtual 

operation` 

Cancel the last virtual operation on the List of Pending Operations 

Redo `the last virtual 

operation` 

Cancel the last undo virtual operation on the List of Pending Operations 

View Changes… Display the List of Pending Operations 

Apply Changes Launch the real execution of virtual operations 

Discard All Changes Cancel all virtual operations on the List of Pending Operations 

Reload Disk Info Refresh the current information about disks 

Wizards 

Express Create Partition… Create an NTFS partition and make it ready for work 

Format Partition… Format a partition of any file system 

Delete Partition… Delete a partition of any file system 

Express Resize Partitions… Increase free space on one partition by up-taking the unused space of an 

adjacent partition 

Copy Partition… Create a partition copy 

Hard Disk 

Update MBR Update MBR (Master Boot Record) of the selected hard disk 

Properties… Get in-depth information on the properties of selected hard disk 

Partition 

Create Partition… Create a partition 

Format Partition… Format a partition 

Delete Partition… Delete a partition 

Move/Resize… Move/Resize the selected partition 

Convert File System… Convert file system of the selected partition 

Assign Drive Letter… Assign drive letter to the selected partition 

Remove Drive Letter… Remove drive letter for the selected partition 
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Hide Partition… Make the selected partition unavailable for the operating system 

Unhide Partition… Make the selected partition available for the operating system 

Mark Partition as Active Make the selected partition bootable by default 

Mark Partition as Inactive Make the selected partition non-bootable by default 

Change Volume Label… Change volume label of the selected partition 

Defragment Partition… Defragment data on the selected FAT or NTFS partition 

Test Surface… Test surface of the selected partition/block of free space 

Check File System 

Integrity… 

Check the selected partition for possible file system errors 

Properties… Get in-depth information on the properties of selected partition 

View 

Layouts Manage the Launcher layout with several predefined profiles 

Toolbar Manage the Tool Bar representation: show / hide standard and navigation 

buttons, text labels and large icons 

Status Bar Display the Status Bar 

Common Tasks Bar Display the Common Tasks Bar 

Disk Map Legend Display the Disk Map legend 

Properties and Commands Display the Explorer Bar 

Disk Map Location Select whether the Disk Map will be located on the top of the main window or 

at the bottom 

Help 

Help Open the Help system (you can also do it by pressing F1) 

About Open the dialog with information about the program 

 

 

The Main Menu contents available at the moment may vary depending on the selected 

object. 

 

Tool Bar 

The Toolbar provides fast access to the most frequently used operations: 

BUTTON FUNCTIONALITY 

 

Increase free space on one partition 

by up-taking the unused space of an 
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adjacent partition 

 

Defragment the selected partition 

 

Switch to Express launcher 

 

Open the Help system 

Virtual Operations Bar 

The program supports previewing the resulting layout of hard disks before actually executing operations (so-called 

virtual mode of execution). In fact, when the virtual mode is enabled, the program does not accomplish operations 

immediately, but places them on the List of Pending Operations for later execution. 

The Virtual Operations Bar enables to manage pending operations. 

BUTTON FUNCTIONALITY 

 
Cancel the last virtual operation on the List of Pending Operations 

 
Cancel the last undo virtual operation on the List of Pending 

Operations 

 
Display the List of Pending Operations 

 
Launch the real execution of virtual operations 

 
Cancel all virtual operations on the List of Pending Operations 

 

 

Virtual mode is an effective way of protection from any troubles, since no operations will 

be executed until clicking the Apply button for confirmation, thus giving a second chance to 

weigh all pros and cons of this or that particular operation. The program politely reminds 

the user that there are unsaved changes by showing the following window: 

 

 

Common Tasks Bar 

The Common Tasks Bar is located on the left side of the main window. It is intended for easy access to the program's 

wizards. 

The bar contains several tabs. Each tab includes a separate button bar which can be folded by clicking it. 

Basic Partitioning Tasks 
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Starting the Express Create Partition Wizard to create an NTFS partition and make 

it ready for work. 

 
Starting the Format Partition Wizard to format an existing partition to one of the 

file systems supported by the program. 

 
Starting the Delete Partition Wizard to delete a partition of any file system. 

Advanced Partitioning Tasks 

 
Starting the Express Resize Partitions Wizard to redistribute free space between 

two adjacent partitions. 

Copying Tasks 

 
Starting the Copy Partition Wizard to copy a partition. 

Help and Documentation 

 

Launching the help system (you can also do it by pressing F1). 

 

Opening the page which contains information about the program. This page will 

be displayed in the Explorer Bar. 

Disk Map 

The Disk Map is displayed in the Explorer Bar when the Disk View tab is selected. It is located either at the top or at the 

bottom of the window, depending on the state of the Disk Map Location option (Main Menu: View > Disk Map 

Location). 

As the name infers, the Disk Map displays the layout of physical and logical disks. Physical disks are represented with 

rectangle bars that contain small-sized bars. These small-sized bars represent logical disks. Their color depends on the 

file system of the appropriate partition. 

 

Large-sized bars display the following information about physical disks: 

 Manufacturer, 

 Model. 

Small-sized bars display the following information about logical disks: 

 Serial number, 

 Drive letter, 

 Total size, 

 File system. 
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Furthermore, it is possible to estimate the used disk space by looking at the size of the bar’s shaded area. The program 

offers to choose from several types of the disk layout scaling. It’s done especially to increase the program usability. For 

instance, if you’ve got a high capacity hard drive containing both very large (more than 100 GB) and rather small (less 

than 10 GB) partitions, you can select the logarithmic type to make all partitions readable, otherwise (selecting the 

linear type) you won’t be able to see small partitions at all, but thing strips. On the other hand, if the proportional disk 

layout is critical for you, the linear type is exactly what you need.  

Nevertheless there’s a compromise solution – linear scaling with the minimal limit to small partitions. So if a partition is 

too small it will remain readable. 

Just click on the arrow icon on the top right side of the Disk Map to select the desired scaling type. 

 

Disk Map is synchronized with the Explorer Bar. Thus by selecting a disk on the Disk Map, the Explorer Bar will 
automatically display detailed information on it. 
 

 

The drag-and-drop functionality is not available when the logarithmic type of the disk 

layout is selected. 

 

Explorer Bar 

The Explorer Bar is located in the center of the main window which emphasizes its importance. The bar displays 

reference information including: 

 The help system 

 General information on the product including its name, version and a list of helpful links 

 Detailed information about disks selected on the Disk Map 

According to these categories the Explorer Bar has several tabs: 

 Disk View, which offers the user the following options: 

- Partition List to get a clear-cut picture of the current state of the system hard disks/partitions 

- Properties to view detailed information on the selected partition/hard disk in the bright graphical form 

 

 

You can switch between these components by clicking tabs on the left side of the Explorer 

Bar. 

 

 Help, which contains the program help and general information on the product. 

You can access the desired information by clicking on the appropriate tab. 

The Explorer Bar is a fully-functional embedded HTML browser, which offers the possibility to address, for example, the 

company's website to look through important technical notes or download the latest updates without having to close 

the program.  

The program help is also HTML-oriented. You can read it and follow external links from to get additional information. 
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To easily navigate through browsed pages, the program provides the following functionality: 

BUTTON FUNCTIONALITY 

 
Return to the previously browsed 

page 

 
Open the next browsed page 

 
Stop loading the current page 

 
Refresh the contents of the current 

page 

Partition List 

The Partition List is another helpful tool that enables you to get a clear-cut picture of the current state of the system 

hard disks/partitions. Partitions are sorted according to their starting position. For every item of the list there is the 

possibility to call the context-sensitive popup menu with available operations. Besides, the program provides detailed 

information on all hard disks/partitions found in the system including the following properties: 

   - Name, 

   - Volume label (if exists), 

   - Partition type (Primary/Extended /Logical), 

   - File system type, 

   - Size, 

   - Amount of used and unused (free) space, 

   - Start/End cylinder, 

   - Start/End head, 

   - Start/End sector 

   - Free size in sectors/bytes 

   - Active/Inactive attribute 

   - Hidden/Unhidden attribute 

You may customize outlook of the Partition List by clicking on the arrow icon on the top right side of the panel. 
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By marking a checkbox opposite the required item you can choose whether to display it or not. Besides, you can change 

its order by pressing the Move up or Move down buttons. 

If you don’t need the Disk Map, please click the shown below icon to disable it: 

 

Properties Bar 

The Properties Bar provides information on the selected at the moment partition/hard disk: 

For a hard disk 

 Model, 

 Serial number, 

 Type of hard disk (basic or dynamic), 

 Total size (in GB), 

 Information on geometry of the disk (amount of sectors per track, heads and cylinders). 

For a partition 

 Drive letter assigned to the disk, 

 Volume label (if available), 

 Type of the logical disk, 

 File system (represented by the color of the graph and the selected bar), 
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 Total size, used space and free space (in GB or MB). 

Besides you can modify practically any partition property by clicking on the required value. 

Legend Bar 

The Legend Bar explains the color scheme used for disk and partition presentation. You can hide (or show) the bar with 

the appropriate Main Menu item: View > Disk Map Legend. When it is activated it can be found at the bottom of the 

Explorer Bar.  

The program distinguishes between the following types of known file systems: 

   - FAT16/32 

   - NTFS 

   - Linux Ext2/3/4 

   - Linux ReiserFS 

   - Apple HFS 

Status Bar 

This is the bottom part of the main window. The Status Bar displays menu hints, for each item the cursor points to. 

The user can hide (or show) the bar with the appropriate Main Menu item: View > Status Bar. 

Settings Overview 

The Settings dialog is available from the Main Menu: Tools > Settings. All the settings are grouped into several sections, 

which functions are described in the following paragraphs. The list of sections is placed on the left side of the dialog. By 

selecting a section from the list, you can open a set of options. 

 

  

To get a detailed description to any setting, control, or field of the program just click the 

hint button and then the object you need. 

 

General Options  

 

This section contains a set of general options that will be taken into account during any operation carried out with the 

program: 
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 Enable Initial Backup reminders. If this option is marked, the program will automatically offer to make a backup 

before accomplishing any critical partitioning operation, thus minimizing the risk of data loss. 

 Partition Alignment mode. There are three options you can choose from: 

- Legacy. DOS and Windows OSes before Vista required that partitions had to be aligned to the “disk cylinder” 

or 63 sectors to address and access sectors correctly. It was OK, until 4K hard drives came into scene. When 

partitions are aligned this way on this type of disk, each logical cluster is linked to two physical 4K clusters, 

thus resulting in a double read-write operation. 

- Vista. Since Windows Vista, operating systems do not use the archaic CHS (cylinder/head/sector) addressing 

scheme, but the Logical Block Addressing (LBA), where sectors are addressed continuously over the whole 

disk drive. It is optimal for both, 512B and new 4K disk drivers. 

- Inheritance. Select the option to disable automatic alignment of partitions. 

 Check FS integrity policy. Accomplishment of any data-sensitive operation (resize, move, merge, redistribute, 

change cluster size, etc.) is potential with data loss. To minimize this risk, it’s recommended to check integrity of 

your file system before this type of operations, despite the fact that it’s quite time consuming. We offer you 

several options to let you choose, which is best for you: 

- Always. Maximum protection, but minimal performance. The file system integrity will be checked each time 

it’s necessary to guarantee the maximum protection for the on-disk data. 

- Once. Standard protection with acceptable performance. The file system integrity will be checked for each 

volume only once just before accomplishing data-sensitive operations. 

- Never. No protection, but maximum performance. If you’re not 100% sure your disk is rock solid, please do 

not use this option. 

 Data Loss Protection mode. To guarantee safety for your information when a data-sensitive operation has been 

abruptly interrupted as a result of a computer reset, or a power outage, there are several techniques, that 

correspond to the options below: 

- Do not protect. No protection, but maximum performance. If you’re not 100% sure you’re completely safe 

from a power outage, or an accidental reset of your computer, please do not use this option.  

- Reset. Standard protection with acceptable performance. Maintaining a special journal, our program 

enables to automatically complete a data-sensitive operation interrupted by an accidental reset of your 

computer from our bootable recovery media, thus reviving the corrupted partition. 

- Power loss. Maximum protection, but minimal performance. Besides journaling, our program will also 

disable cache of your disk when accomplishing data-sensitive operations to avoid data loss even in case of a 

power outage. 

General Copy and Backup Options  
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This section contains a set of options that will be taken into account during copy and backup operations: 

 HDD raw processing. Mark the checkbox to copy/back up a hard disk in the sector-by-sector mode, thus 

ignoring its information structure (e.g. unallocated space or unused sectors of existing partitions will be 

processed as well). This can help to avoid problems with hidden data created by certain applications or the 

system administrator. However, it will take more time to accomplish the operation. 

 Partition raw processing. Mark the checkbox to copy a partition in the sector-by-sector mode to successfully 

process unknown file systems. However it is not recommended to enable this option when working with 

supported file systems as it takes more time to accomplish the operation. 

 Skip OS auxiliary files. Mark the checkbox to skip OS auxiliary files (like pagefile.sys, hiberfil.sys, etc.), thus 

reducing the operation time and the resulted size of the backup image. 

Hot Processing Options  

 

In this section you may configure the hot processing mode: 

 Enable hot processing. Mark the checkbox to enable the so called hot data processing mode that is specially 

designed to process data without restarting your operating system. 

 Hot processing technology. From the pull-down list you can select the required hot processing technology. 

 Always use hot processing. Select the option to process partitions without making them locked. Thus you will 

be able to keep working with them as usual. 

 Use hot processing only when partition is locked. Select the option to use the hot processing only when 

partitions are locked and cannot be processed without restarting the computer. Please keep in mind, that once 

you start any operation on a partition in this mode, it will automatically be locked by the program, thus you 

won't be able to keep working with it as usual. 

 Hot processing temporary drive. Here you can select a disk drive that will be used to store the temporary hot 

backup data (by default – C:). 

 Attempts to start VSS. Here you can set how many attempts to start Microsoft VSS the program is to do before 

automatically rebooting the system and accomplishing the operation in a special boot-up mode. 

 Timeout between attempts (in seconds). Here you can set a time period between different attempts to start 

Microsoft VSS. 
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 Switch between hot processing technologies. Mark the checkbox to automatically switch between Paragon Hot 

Processing and Microsoft VSS if one of them is unavailable at the moment. 

Partitioning Options 

 

This section contains a set of options that will be taken into account during partitioning operations: 

 Enable 64 KB cluster size for FAT16. Mark the checkbox to enable 64KB clusters for FAT16 partitions. Thus you 

will be able to create FAT16 partitions up to 4GB in size 

 

 

Due to the maximum cluster size of 32KB for Windows 95/98/ME or MS DOS, FAT16 

partitions larger than 2GB are not reliably accessible under these operating systems. 

 

 Request confirmation before partition deletion. Mark the checkbox to activate an additional security 

mechanism. Thus when going to delete a partition you will be automatically requested to enter its label. 

 Request confirmation when converting FAT16 to FAT32. Mark the checkbox to automatically request 

confirmation before converting FAT16 to FAT32. There are a number of situations when this kind of conversion 

is the only way out to accomplish the operation. For instance, you are going to migrate your system to a larger 

hard disk with the proportional resize of existing partitions, what is very convenient. As a result you can get 

original FAT16 partitions go beyond the 4GB limit. Thus without conversion to FAT32, this operation will in no 

way be possible to accomplish. The same goes for any copy hard disk/partition or restore hard disk/partition 

operation involving an extra upsizing. 

Virtual Mode Options 

 

In this section you may configure the virtual mode: 

 Allow virtual mode. Mark the checkbox to enable the virtual mode. It is an effective way of protection from any 

troubles, since no operation will be executed until confirmation, thus giving you a second chance to weigh all 

pros and cons of this or that particular operation. 

 

 
We strongly recommend you to enable this mode. 
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 Close progress dialog automatically. Mark the checkbox to automatically close the progress dialog after 

accomplishing operations. 

File System Conversion Options 

 

This section contains a set of options that will be taken into account when converting FAT and NTFS file systems. By 

default, the program takes locale (regional) settings from the system. Problems might occur however because of 

different standards for file names and file time stamps (Created, Modified and Last Access Time) of NTFS and FATxx file 

systems. 

To tackle problems of that kind you can manually set: 

 Time zone to use during the convert operation. NTFS keeps file timestamps in GMT (Greenwich Mean Time) 

while FAT uses a fixed local date and time. The program takes proper account of these differences and enables 

to adjust timestamp values. 

 

 
An incorrectly chosen time zone might lead to inability to launch certain software. 

 

 Language for file names to use during the convert operation. NTFS stores file names in Unicode while 

FAT/FAT32 uses ANSI to save short file names (also called the DOS aliases). The codepage information is 

required for the correct conversion of non-English file names from Unicode to ANSI and vice versa. 

 

 

An incorrectly chosen codepage will certainly result in corruption of non-English file 

names. 

 

 Request confirmation of settings before NTFS < - > FAT/FAT32 conversion. Mark the checkbox to automatically 

display the local settings dialog to check and modify (if necessary) the default parameters before launching the 

convert file system operation. 

Defragmentation Options 

 

In this section you may set the preferable defragmentation mode: 
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 Fast mode. Partitions will be defragmented rather fast (a 10-30% gain depending on the fragmentation level), 

but a power outage, hardware malfunction or a system failure during the operation might lead to the data loss. 

 Safe mode. To guarantee protection of your data during the operation, the program will allocate some free 

space (not less than the on-disk largest file) on the defragmented at the moment partition to make a duplicate 

of every processed file. Thus we strongly recommend you to use this very mode. 

Log Files Options 

 

In this section you can specify a storage life span for the stubact.log file: 

 Infinite not to empty the file ever; 

 Minimal to have the file emptied all the time; 

 Custom to set a certain storage life span for the file. Please note, once the defined period has been expired, the 

file will be emptied. 

 

 

We strongly recommend you not to choose the Minimal option, as in case of having 

problems with the program, our Support Team won’t be able to study operation logs, thus 

help you out. 

 

Viewing Disk Properties  

The main tool to view in-depth information on the properties of hard disks is the Disk Map. It represents the actual state 

of the computer’s hard disks. 

Generally the hard disks are represented on the map by rectangular bars, which also contain small-sized bars. The small-

sized bars represent logical disks (partitions). When you select a large-sized bar, the Explorer Bar displays information 

about the disk in a bright, graphical form. 
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The model and serial number of the disk serve as the title of the browsed page. The disk layout is shown in form of a 

circular graph, where the color of a sector corresponds to a file system of an appropriate partition. On the right you may 

see a table, which contains the following information: 

 Type of hard disk (basic or dynamic), 

 Total size (in GB), 

 Information on geometry of the disk (amount of sectors per track, heads and cylinders). 

Below there is a list of available wizards. If you click a corresponding record the appropriate wizard will be started. All 

default values for the operation parameters will correspond to the disk’s settings. The list of wizards contains a detailed 

description of tasks that can be performed by the wizard. This nullifies the possibility of selecting the wrong wizard. 

 

When you select a small-sized bar (i.e. corresponding to a logical disk) the Explorer Bar will display information on it as 

well. The page title will contain a drive letter, which is assigned to the disk. The disk layout graph will be colored in 

accordance with the volume ratio of the used space to the free space (the light colored sector). The table on the right 

will contain the following information: 

 Volume label (if available), 

 Type of the logical disk, 
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 File system (represented by the color of the graph and the selected bar), 

 Total size, used space and free space (in GB or MB). 

Below there is a list of wizards, which may be called for this disk. All default values of parameters will correspond to the 

disk settings. 

Copy Tasks 

In this chapter you will find all the information necessary to make a copy of a hard disk or a separate partition. 

Cloning Partitions 

You can duplicate partitions to protect oneself from downtime in case of a system malfunction or for cloning sample 

partitions. The program enables to duplicate all partition data including files, the exact structure of directories and file 

system metadata (location of files, security information, access quotas, etc.). 

The Copy Partition Wizard will help you copy a partition of any file system. To minimize the possibility of making any 

mistake, the wizard provides auxiliary information on every single option. Moreover you can get an in-depth description 

to any setting, control, or field of the wizard just by clicking the hint button and then the object you need. 

Startup 

 In the Main Menu: select Wizards > Copy Partition… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Setup 

The wizard offers the following steps to accomplish the copy partition operation: 

 The partition to copy. Select a partition you want to copy. 

 

 Destination disk. Select a hard disk with enough unallocated space to perform the operation. 

 

 



29 

Copyright© 1994-2011 Paragon Software Group. All rights reserved. 

 

The program enables to copy a partition to a block of free space, which is smaller than the 

partition itself, taking into account only actual amount of data. 

 

 Copy parameters. The wizard enables to specify the following options: 

 

- Partition size. Define the size (in Mb) of the copied partition. 

- Free space before. Define the position (in Mb) of the copied partition relative to the beginning of the available 

range of disk space. 

- Free space after. Define the amount of trailing free space (in Mb) at the end of the available range of disk 

space. 

 

 

Partition size and position may also be defined by using the drag-and-drop technique. To do 

that, just carry out the required operation on the Disk Map. 

 

Result 

After the operation is completed you receive a fully functional duplicate of the existing partition. 

Partition Management 

In this chapter you will find all the information necessary to carry out partitioning operations supported by the program. 

Basic Partitioning Operations 

Here you can learn how to accomplish basic partitioning operations (create, format, delete). 

Creating Partitions 

The program provides the ability to create a new partition within a block of un-partitioned space. 

Restrictions 

1. Do not use the Create Partition function in order to undelete the last deleted partition. 

2. The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert a free 

space on an existing partition to a new partition. 

3. The program cannot create new partitions on Dynamic Disks. 

Express Create Partition Wizard Startup 

 In the Main menu: select Wizards > Express Create Partition… 
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There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Dialog Startup 

1. Select a block of free space on the Disk Map; 

2. Select in the Main Menu: Partition > Create Partition. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Express Create Partition Wizard Setup 

Thanks to a highly intelligent work algorithm, the wizard requires minimal involvement in the operation, thus you only 

need to choose a method you find the most suitable to create the partition (if several available), which actually differ in 

the amount of space to allocate. For easy perception, you can see the resulted disk layout on the disk map by selecting 

this or that mode. 

 

 

  

The number of available methods depends on your disk layout. 

To learn more on the way the wizard works, please click the corresponding link on the first 

page of the wizard. 

 

Dialog Setup 

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Yes 

button to confirm the operation. 
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 Define whether the partition will be Primary, Extended or Logical. You can choose the desired partition type 

from the pull-down list. As a matter of fact, the available alternatives fundamentally depend on the selected 

block of free space - within the Logical free space, only Logical partitions can be created; Within the Primary free 

space, both Primary partitions or the Extended Partition can be created. 

 Partition Size. Define the size (in Mb) of the new partition. 

 Free space before. Define the position (in Mb) of the new partition relative to the beginning of the block of free 

space. 

 Free space after. Define the amount of trailing free space (in Mb) at the end of the new partition. 

 

  

Partition size and position may also be defined by using the drag-and-drop technique. To do 

that, just carry out the required operation on the Disk Map. The virtual operations are to be 

available. 

 

 File system for new partition. From the pull-down list select a file system the newly created partition will be 

formatted to, otherwise the partition will remain unformatted (so that it will not be ready to use). 

 Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually 

used for drive identification. 

 Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly 

formatted partition. 

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). 

To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on 

the chosen file system, the following options become available: 
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 Use OS built-in routine. Mark the option to restrict the available values according to the used OS. 

 Whether the surface test will be performed. Define the level of the surface check to make the program find bad 

and unstable sectors and mark them unusable in the file system metadata. 

 The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set 

the number of sectors to be reserved for the boot area on the partition with this spinner control. 

 The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum 

amount of files/directories to be placed in the Root Directory on the FAT16 partition. 

 The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control. 

 

  
Number of available options depends on the selected file system type. 

 

Result 

After the operation is completed you receive a fully functional partition. 

Available operation scenarios: 

 Creating a new partition to detach operating system from the rest of data 

Formatting Partitions  

Any partition should contain some file system to be used for keeping data. The process of installing a file system is 

commonly known as formatting. A huge variety of file systems have been developed these days. 

Supported File Systems 

The program provides the ability to format partitions of the following file systems: 

   - FAT12 & FAT16 

   - FAT32 

   - HFS+ 

   - NTFS 

   - Ext2 

   - Ext3 

   - Ext4 

   - Linux Swap v. 2 
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Wizard Startup 

 In the Main menu: select Wizards > Format Partition… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Dialog Startup 

1. Select a partition on the Disk Map; 

2. Select in the Main Menu: Partition > Format Partition. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Wizard Setup 

The wizard offers the following steps to accomplish the operation: 

 Partition to format. Select a hard disk (if the computer has several hard disks) and then the required partition to 

format. 

 

 

  
As a result of this operation contents of the selected partition will be lost. 

 

 Partition properties. On the next page of the wizard you can set the following partition parameters: 
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- Partition type. From the pull-down list select the desired file system type. In fact, the program displays only 

those file systems that can correctly be placed to the selected partition, taking its capacity into account. 

- Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually 

used for drive identification. 

- Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly 

formatted partition. 

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). 

To activate the advance mode, you need to mark the appropriate option at the foot of the page. When it is marked, the 

next page enables to define: 

 

 Use OS built-in routine. Mark the checkbox to restrict the available values according to the used OS. 

 Whether the surface test will be performed. Define the level of the surface check to make the program find bad 

and unstable sectors and mark them unusable in the file system metadata. 

 The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set 

the number of sectors to be reserved for the boot area on the partition with this spinner control. 

 The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum 

amount of files/directories to be placed in the Root Directory on the FAT16 partition. 

 The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control. 

 

  
Number of available options depends on the selected file system type. 

 

Dialog Setup 

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Format 

button to confirm the operation. 
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 File system. From the pull-down list select the desired file system type. In fact, the program displays only those 

file systems that can correctly be placed to the selected partition, taking its capacity into account. 

 Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually 

used for drive identification. 

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). 

To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on 

the chosen file system, the following options become available: 

 

 Use OS built-in routine. Mark the checkbox to restrict the available values according to the used OS. 

 Whether the surface test will be performed. Define the level of the surface check to make the program find bad 

and unstable sectors and mark them unusable in the file system metadata. 

 The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set 

the number of sectors to be reserved for the boot area on the partition with this spinner control. 

 The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum 

amount of files/directories to be placed in the Root Directory on the FAT16 partition. 

 The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control. 

 

  
Number of available options depends on the selected file system type. 

 

Result 

After the operation is completed you receive a fully functional partition formatted to the specified file system. 

Deleting Partitions 

Wizard Startup 

 In the Main menu: select Wizards > Delete Partition… 
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There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Dialog Startup 

In order to start the operation you should take the following steps: 

Launcher 

1. Select a partition on the Disk Map; 

2. Select in the Main Menu: Partition > Delete Partition. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Wizard Setup 

The wizard offers the following steps to accomplish the operation: 

 Partition to delete. Select a hard disk (if the computer has several hard disks) and then the required partition to 

delete. 

 

 

  
As a result of this operation contents of the selected partition will be lost. 

 

 Merge free blocks. As a result of the operation you may get several blocks of the unallocated space on the hard 

disk. So choose whether to merge them all and place at the beginning of the disk or at the end by selecting the 

required operation from the pull-down list. 
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Dialog Setup 

Initially the program suggests you just to remove references to the selected partition from the Partition Table.  

 

 Enter the volume label to confirm deleting. To confirm deletion of the selected partition, enter its Volume 

Label. The current volume label is displayed above. 

 Do not ask volume label next time. Mark the option to inhibit confirmation next time you start the dialog. 

Result 

By default, the operation takes only a fraction of a second. However, the program waits until Windows completes the 

modification of the disk layout. 

Advanced Partitioning Operations 

Here you can learn how to accomplish advanced partitioning operations. 

Redistributing Unused Space between Partitions 

Express Resize Partitions Wizard 

The Express Resize Partitions Wizard enables to easily increase free space on one partition by up-taking the unused 

space of an adjacent partition of your hard disk. 

Startup 

 In the Main menu: select Wizards > Express Resize Partitions… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Setup 

The wizard offers the following steps to accomplish the operation: 

 Adjacent partitions to resize. Click on the left partition of the pair of partitions you need to redistribute the 

unused space between, as the right one will be selected automatically. 
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 Resulted size of partitions. Redistribute the unused space between the partitions with the slider or manually by 

entering the required value. 

 

Result 

After the operation is completed the unused space between the specified partitions will be redistributed according to 

your needs. 

Available operation scenarios: 

 Increasing size of a system partition by taking unused space of an adjacent logical partition 

Moving/Resizing Partition 

The Move/Resize Partition function allows you to resize or change location of any partition without destroying its data. 

In order to move/resize a partition you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Select in the Main menu: Partition > Move/Resize Partition… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. Define parameters of the operation. 
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 Volume size. Define size (in Mb) of the modified partition. 

 Free space before. Define the partition position (in Mb) relative to the beginning of the available range of 

disk space. 

 Free space after. Define the amount of trailing free space (in Mb) at the end of the available range of disk 

space. 

 Sector to sector move. Mark the checkbox to move the partition in the sector-by-sector mode to process its 

unused space as well. This can help to avoid problems with hidden data created by certain applications or 

the system administrator. However, it will take more time to accomplish the operation. 

 

  

Partition size and position may also be defined by using the drag-and-drop technique. To do 

that, just carry out the required operation on the Disk Map. The virtual operations are to be 

available. 

When resizing a FAT16 partition beyond the 2GB limit (maximum file system size), the 

partition will automatically be converted to FAT32. 

The program enables to enlarge NTFS partitions (system, locked) without rebooting 

Windows and interrupting its work, providing 100 percent guarantee that your data is kept 

intact. 

 

4. The operation will be performed immediately after confirmation. 

Available operation scenarios: 

 Increasing size of a system partition by taking unused space from any other 

Converting File System 

With our program you can change type of the used file system without destroying its data. While performing the 

operation, it first checks the current file system for consistency and then verifies whether the on-partition data meet the 
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requirements of the desired file system or not. After having passed the testing, the program re-organizes the file system 

metadata and user files. 

The program enables to convert the following file system types: 

- FAT16 > NTFS, FAT32 

- FAT32 > NTFS, FAT16 

- NTFS > FAT16, FAT32 

- Ext2 > Ext3 

In order to convert a file system you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Select in the Main menu: Partition > Convert file system… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. Initially the program suggests some consistent values for all parameters. In most cases, you can just press the 

Convert button to confirm the operation. 

 

 New file system. From the pull-down list choose a file system you would like to convert to. Actually the 

program only displays variants available for the operation, taking into account the current parameters of the 

selected partition and limitations of the used file system. 

 New cluster size. Define the cluster size for the partition. This parameter can have a profound effect on the 

overall performance. In a nutshell, larger clusters waste more space, but generally provide for slightly better 

performance, because of less fragmentation. So be particularly careful with it. 

 

  

The cluster size value is expressed in sectors per cluster. To get it in Kbytes, please divide it 

into half. 

You may only decrease the current cluster size. 

 

 Surface test level. Define the level of the surface check to make the program find bad and unstable sectors 

and mark them unusable in the file system metadata. 

4. The operation will be performed immediately after confirmation. 
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Changing Partition Attributes 

This chapter explains how you can change partition attributes (Active flag, Hidden flag, Volume Label, etc.). 

Mark Partition Active/Inactive 

The program enables to set an active/inactive flag for primary partitions of a hard disk. By default, an operating system 

will boot only if its partition is active or bootable. 

In order to mark a partition active/inactive you should take the following steps: 

1. Select a primary partition on the Disk Map. 

2. Select in the Main Menu: Partition > Mark Partition as Active/Inactive. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

 

3. The operation will be performed immediately after confirmation. 

 

 

There can only be one active partition on a hard disk, otherwise your operating system will 

fail to boot. 

 

Hide/Unhide Partition 

The program allows you to hide/unhide primary and logical partitions. By default, an operating system does not mount 

hidden partitions, thus preventing access to their contents. 

In order to hide/unhide a partition you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Select in the Main Menu: Partition > Hide/Unhide Partition. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. The operation will be performed immediately after confirmation. 

 

 

It is strongly recommended not to hide the system partition. Otherwise your operating 

system will fail to boot. 
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Set Label of a Partition 

The Partition Label is a small textual field (up to 11 characters) that is located in the partition's boot sector. It is 

detectable by any partitioning tool and is used for notification purposes only. 

In order to change a partition label you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Select in the Main Menu: Partition > Modify > Change Volume Label. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. Enter a label for the selected partition. 

 

4. The operation will be performed immediately after confirmation. 

Hard Disk Management 

In this chapter you will find all the information necessary to carry hard disk operations supported by the program. 

Updating MBR 

The program enables to overwrite the current bootable code in the MBR (Master Boot Record) by the standard 

bootstrap code. This can help to repair a corrupted bootable code of a hard disk resulted from a boot virus attack or a 

malfunction of boot management software. 

In order to update MBR of a hard disk you should take the following steps: 

1. Select a hard disk on the Disk Map. 

2. Select in the Main Menu: Hard Disk > Update MBR. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

 

3. The operation will be performed immediately after confirmation. 
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Extra Functionality 

This chapter describes the supplementary functionality available in the program. 

View Partition/Hard Disk Properties 

The program enables to obtain in-depth information on the properties of hard disks and partitions. Besides the general 

information, such as capacity, used space or file system type it provides the possibility to get info on hard disk geometry, 

cluster size, exact partition location, etc. 

To get properties on a partition/hard disk, please do the following: 

1. Choose a partition/hard disk on the Disk Map. 

2. Select in the Main Menu: Partition/Hard Disk > Properties… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

 

In the opened dialog information will be grouped according to its properties, thus by clicking tabs you can get 

information you need. 

Mount Partition 

The program enables to assign or remove drive letters of existing formatted partitions. 

Assign Drive Letter 

In order to mount a partition you should take the following steps: 
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1. Select a partition on the Disk Map.  

2. Select in the Main Menu: Partition > Assign Drive Letter… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. Specify a drive letter for the selected partition. Initially the program suggests some consistent value for this 

parameter. So you may just press the Yes button to confirm the operation. 

 

However you can manually define the required letter by selecting it from the pull-down list of available drive 

letters.  

4. The operation will be performed immediately after confirmation. 

Remove Drive Letter 

In order to un-mount a partition you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Select in the Main Menu: Partition > Remove Drive Letter. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. The operation will be performed immediately after confirmation. 

 

 

Modifying drive letter of the system partition will result in inability to boot the operating 

system. 

After having processed partitions with installed software, some programs may not run 

properly. 

 

Defragment Partition 

Defragmentation is the process of rewriting parts of a file to contiguous sectors on a hard disk to increase the speed of 

access and retrieval. When files are updated, the computer tends to save these updates on the largest continuous space 

on the hard disk, which is often on a different sector than the other parts of the file. When files are thus fragmented, 

the computer must search the hard disk each time the file is opened to find all of the file's parts, which slows down 

response time. 
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The program provides the necessary tool for the defragmentation of NTFS and FAT partitions. 

In order to start the operation you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Select in the Main menu: Partition > Defragment > Defragment Partition… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. Initially the program suggests some consistent values for all parameters. In most cases, you can just press the 

Yes button to confirm the operation. 

 

 Directories Placement. From the pull-down list select the way how to sort directories. 

 Sort by size. Sort files according to their size. 

 Sort by time. Sort files according to the last time of update. 

In addition, there is the possibility to make further detailed settings (although the default values will do in most 

cases). To activate the advance mode, you need to click the More options button at the foot of the dialog page: 

 

 Skip auxiliary files. Mark the option to ignore contents of the PAGEFILE.SYS and HIBERFIL.SYS system files. 

These files are used temporarily in the operating system. 

 Defragmentation Mode. Select the preferable defragmentation mode. 
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4. The operation will be performed immediately after confirmation. 

Available operation scenarios: 

 Hard Disk Optimization 

Test Surface 

The program enables to test surface of existing partitions and blocks of free space for bad or unstable sectors. If found 

any it automatically marks them unusable in the file system metadata, thus minimizing the risk of data loss. 

In order to start the surface test you should take the following steps: 

1. Select a partition or a block of free space on the Disk Map. 

2. Select in the Main Menu: Partition > Test Surface… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. From the pull-down list choose the level of the surface check. 

 

4. The operation will be performed immediately after confirmation. 

Check File System Integrity 

The program allows you to check integrity of a file system. It can be used to detect possible file system errors before 

performing any operation on a partition. 

To start the system integrity check you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Select in the Main Menu: Partition > Check File System Integrity 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 
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3. The operation will be performed immediately after confirmation. 

View Logs 

With a handy dialog you can study logs on any operation carried by the program. To make this job as easy as possible, all 

the information is structurally divided, besides there is the possibility to see the disk layout before and after an 

operation, what is very convenient.  

In order to view logs on carried out operations select in the Main Menu: Tools > View Log Files 

 

Typical Scenarios 

This chapter lists a number of the most frequently used scenarios that may be accomplished with the program. You can 

find here useful recommendations and descriptions of operations. 

Resize Scenarios 

Creating a new partition to detach operating system from the rest of data 

Let’s assume that you’re a rank and file user who is most likely to have only one hard disk with only one partition (the 

only partition is always system). To secure yourself against a system malfunction or a virus attack you’ve got nothing to 

do, but make a backup of the whole partition, which besides the operating system itself contains all your family photos, 



48 

Copyright© 1994-2011 Paragon Software Group. All rights reserved. 

favorite films and music, program distributives, whatever. As a result you’ll get a very huge backup image. You can easily 

tackle this issue however by detaching your operating system from the rest of data. 

To create a new partition on your hard disk, please do the following: 

1. Click the Express Create Partition item of the Wizards menu. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

2. On the Wizard's Welcome page, click the Next button. 

3. Choose a method you find the most suitable to create the partition. The wizard is especially designed to 

minimize your participation in finding an appropriate place for it and its resulted size. The only thing you’re to 

do is to choose between several modes. The most relevant thing here is the amount of space that will be 

allocated for that partition. For easy perception, you can see the resulted disk layout on the disk map by 

selecting this or that mode. 

 

 

  

The number of available methods depends on your disk layout. 

To learn more on the way the wizard works, please click the corresponding link on the first 

page of the wizard. 

 

4. That’s basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do 

with the system partition resize, like we do in our case, you will be asked to restart your computer in a special 

boot-up mode to accomplish the operation. So click the appropriate button to agree. 
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5. In the Progress window you can see in real-time a detailed report on all actions carried out at the moment. 

After completing the operation your computer will be automatically restarted back to Windows where you can see the 

newly created NTFS partition. Now you’ve got a place to keep your stuff apart from Windows. 

Increasing size of a system partition by taking unused space of an adjacent partition 

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming 

applications and system updates your system partition has started to suffer from the lack of free space. But an adjacent 

partition has a plenty of redundant space. That’s just enough to make your system partition suffer no more. 

To increase size of a system partition by taking unused space from an adjacent partition, please do the following: 

1. Click the Express Resize Partitions item of the Wizards menu. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

2. On the Wizard's Welcome page, click the Next button. 

3. Click on your system partition. By doing that, the wizard will automatically select an adjacent partition as well. 

This partition will later act as a space donor. 
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If you’ve got more than two partitions on your hard disk and a partition you need to 

increase is surrounded by other partitions, you’ve got the choice to choose which partition 

will act as a space donor. Just click on the left partition of the pair, as the right one will be 

selected automatically. 

 

4. Increase size of the system partition with the slider or manually by entering the required value. Please note, 

when you change size of one partition the size of the other will be changed as well, thus redistributing the 

unused space between the partitions. 

 

5. On the next page of the wizard you need to confirm the operation by selecting the appropriate option. 

 

6. That’s basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do 

with the system partition resize, like we do in our case, you will be asked to restart your computer in a special 

boot-up mode to accomplish the operation. So click the appropriate button to agree. 
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7. In the Progress window you can see in real-time a detailed report on all actions carried out at the moment. 

After completing the operation your computer will be automatically restarted back to Windows where you can see that 

your system partition is bigger now. 

Increasing size of a system partition by taking unused space from any other 

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming 

applications and system updates your system partition has started to suffer from the lack of free space. But one of your 

partitions has a plenty of redundant space. That’s just enough to make your system partition suffer no more. 

To increase size of a system partition by taking unused space from any other on-disk partition, please do the following: 

1. Click Switch to Full Scale Launcher in the Express Launcher. 

2. In the main window select the required hard disk (if several) on the Disk Map. 

 

3. Choose a space donor partition and then call the context menu for it (right click of the mouse button) to launch 

the Move/Resize dialog. 
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4. In the opened dialog shift the edge of the partition to the right by the drag-and-drop technique. While doing 

this, free space from the partition will be released (displayed in aqua-green). You can also do it manually by 

entering the exact size of free space. Click the Yes button to continue. 

 

5. Now you’ve got a block of free space to add to the system partition. You cannot do it directly however, but by 

carrying out a number of extra move/resize operations. 

 

6. Since the block of free space is within the extended partition, you need to take it out first. The program enables 

to resize the extended partition only when there’s a block of free space adjoining its borders. In our case it’s 

between two logical disks. So we need to move it. To do that, please select the first logical partition and then 

call the context menu for it (right click of the mouse button) to launch the Move/Resize dialog. 
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7. At first shift the right edge of the partition to the right, then do the same with the left edge. Make sure the 

partition size has been left unchanged. 

 

8. Now you can resize the extended partition to take the block of free space out of it. Call the context menu for it 

(right click of the mouse button) to launch the Move/Resize dialog. 

 

 
Call a context menu for the extended partition (with the blue border), not the logical one. 

 

9. In the opened dialog shift the edge of the extended partition to the right. 
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10. The block of free space has been released. 

 

11. Now you need to move the second primary partition just the way we did it with the logical partition to make the 

block of free space adjoin the system partition. 

 

12. Finally increase size of the system partition. Call the context menu for it (right click of the mouse button) to 

launch the Move/Resize dialog. 

13. In the opened dialog shift the edge of the partition to the right, thus increasing its size. 

 

14. Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to 

confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual 

Operations Bar. 
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15. The program will require the system restart to accomplish the operation in a special boot-up mode. Click the 

appropriate button to agree. 

Hard Disk Optimization 

To defragment an NTFS or FAT partition, please do the following: 

 

  

You must have administrator’s privileges to accomplish defragmentation of the system 

partition. 

 

1. In the main window, select a partition you want to defragment on the Disk Map. 

 

2. Launch the Defragment Partition dialog by calling the popup menu for the selected partition (right click of the 

mouse button) and then selecting the menu item: Defragment Partition… 

 

3. In the opened dialog define settings of the operation. To improve the performance we recommend you to mark 

the Do not save content of the Pagefile.sys or (and) Hiberfile.sys checkbox as these files are only needed for 

the current Windows session. 
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The Defragment Partition dialog offers a number of additional parameters that can also be 

of help. However here we pay attention to the most relevant to fulfill our task. 

 

4. Start the operation by clicking the Yes button. 

Troubleshooter 

Here you can find answers to the most frequently asked questions that might arise while using the program. 

1. I try to run an operation, but the program claims my partition is in use and suggests restarting the computer. 

There are a number of operations that cannot be performed while your partition is in use (or locked in other 

words). Please agree to reboot your machine to make the program accomplish the operation in a special boot-

up mode. 

2. I run an operation and restart the machine as required, but it just boots back into Windows without 

accomplishing the operation. 

Please run 'chkdsk /f' for the partition in question. 

3. I cannot create a new partition on the disk. 

There can be a number of reasons for that: 

 The program cannot create a new partition on a dynamic disk. 

 The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert 

a free space on an existing partition to a new partition. 

4. I cannot copy a partition. 

There can be a number of reasons for that: 

- The source or target disk you select is a dynamic disk; 

- 4 primary partitions (or three primary partitions and an extended one) already exist on the target disk. 

5. I need to copy a partition. But when selecting a place where to make a copy, I always get a crossed circle sign no 

matter which partition is selected. 

The program enables to copy a partition only to a block of un-partitioned space. If you don’t have a block of free 

space on your hard disk, please delete or reduce an existing partition to accomplish the operation. 

6. I cannot do anything with my USB flash drive. I get a crossed circle sign when trying to select any area on it. 
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Some USB flash drives don't have the MBR (Master Boot Record), that’s the cause of your problem. To fix the 

issue please use the Update MBR function of our program or 'fixmbr' of the Windows installation disc to write a 

standard code to your flash drive. 

7. When trying to back up my system the program asks to restart the computer. 

Most likely the Hot Processing mode is disabled. Please make it active in the program settings. 

8. When backing up a partition with the VSS (Volume Shadow Copy Service) mode, the program throws "VSS could 

not be started for processed volume". 

Most likely you try to back up a FAT32 partition, which is not supported by VSS. Please use the Paragon Hot 

Processing mode instead. 

9. I cannot back up my hard disk to an external hard drive. Once started, the operation is aborted with the 

following error: Hard Disk management, Error Code 0x1100a. What is wrong here? 

The problem is that the Microsoft VSS service is set as the default Hot Processing mode in the program. But this 

service has not been started in your WindowsXP/Windows2003/Vista. Please start this service (right click on My 

Computer > Manage > Services > find Microsoft Volume Shadow Copy Service and make it active. Set also to 

start it automatically). 

10. When running a backup operation with the Paragon Hot Processing mode enabled, I get an error: error code 

0x1200e "Internal error during Hot Backup" 

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer's tool. 

You can find a name of the tool you need here: http://kb.paragon-software.com 

11. When running a backup operation with the Microsoft VSS mode enabled, I get the following error: error code 

0x12016 "VSS: can't read volume data” 

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer's tool. 

You can find a name of the tool you need here: http://kb.paragon-software.com 

12. When trying to back up to a network share, I get the following error: "i/o error" or "can't open/create file" 

Please check whether you’ve got a permission to write to the selected destination or not. 

13. When trying to restore a backup archive, I get the following error: "Can't restore to current selection" or 

"Archive does not fit" 

Most likely you’re trying to restore a backup of the whole hard disk to a partition or vice versa. 

14. I set up a timetable for a task, but it fails to execute. 

There can be a number of reasons for that: 

- Windows Task Scheduler does not work properly. Check whether it is so or not by scheduling a simple task (call 

Notepad through scheduling); 

- You don’t have permission to write to the selected backup destination. 

Glossary  

Active Partition is a partition from which an x86-based computer starts up. The active partition must be a primary 

partition on a basic disk. If you use Windows exclusively, the active partition can be the same as the system volume.  

In the DOS partitioning scheme, only primary partitions can be active due to limitations of the standard bootstrap. 
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The term backup originates from the time when the best way to protect valuable information was to store it in form of 

archives on external media. It’s become now a general notion to mean making duplications of data for protection 

purposes. 

Bootable Archive is created by adding a special bootable section when backing up the data to CD/DVDs. Thus you will 

be able to restore the data from these archives without having to run the program, but by simply booting from these 

CD/DVDs. 

Cluster is the smallest amount of disk space that can be allocated to hold a file. All file systems used by Windows 

organize hard disks based on clusters, which consist of one or more contiguous sectors. The smaller the cluster size, the 

more efficiently a disk stores information. If no cluster size is specified during formatting, Windows picks defaults based 

on the size of the volume. These defaults are selected to reduce the amount of space that is lost and the amount of 

fragmentation on the volume. A cluster is also called an allocation unit. 

Extended Partition is a partition type you create only on a basic MBR (Master Boot Record) disk. Extended partition is 

used if you want to create more than four volumes on a disk, since it may contain multiple logical drives. 

File System Metadata. The servicing structures of a file system, which contain information about allocating files and 

directories, security information etc, are named the file system metadata. It is invisible for users and regular 

applications because its accidental modification usually makes a partition unusable. 

Hard Disk Geometry. Traditionally, the usable space of a hard disk is logically divided into cylinders, cylinders are 

divided into tracks (or heads), and tracks are divided into sectors. 

The triad of values {[Sectors-per-Track], [Tracks-per-Cylinder], [Amount-of-Cylinders]} is usually named the Hard Disk 

Geometry or C/H/S geometry. 

Tracks and cylinders are enumerated from "0", while sectors are enumerated from "1". These disk parameters play an 

essential role in the DOS Partitioning scheme. 

Modern hardware uses an advanced scheme for the linear addressing of sectors, which assumes that all on-disk sectors 

are continuously enumerated from “0”. To allow backward compatibility with older standards, modern hard disks can 

additionally emulate the C/H/S geometry. 

Hidden Partition. The concept of a "hidden" partition was introduced in the IBM OS/2 Boot Manager. By default, an 

operating system does not mount a hidden partition, thus preventing access to its contents. 

A method of hiding a partition consists in changing the partition ID value saved in the Partition Table. This is achieved by 

XOR-ing the partition ID with a 0x10 hexadecimal value. 

Master File Table (MFT) is a relational database that consists of rows of file records and columns of file attributes. It 

contains at least one entry for every file on an NTFS volume, including the MFT itself. MFT is similar to a FAT table in a 

FAT file system. 

MBR & 1st track of the hard disk is the 0th sector of the disk. MBR (Master Boot Record) contains important 

information about the disk layout: 

- The used partitioning scheme; 

- The starting records of the Partition Table; 

- The standard bootstrap code (or the initial code of boot managers, disk overlay software or boot viruses). 

Generally, the 0th sector is used for similar purposes in all existing partitioning schemes.  

The MBR capacity is not sufficient to contain sophisticated boot programs. That’s why the on-boot software is allowed 

to use the entire 0th track of the disk. For example, boot managing utilities such as LILO, GRUB and Paragon Boot 

Manager are located in the 0th track. 
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Partition ID (or File system ID) is a file system identifier that is placed in the partition. It is used to quickly detect 

partitions of supported types. A number of operating systems completely rely on it to distinguish supported partitions. 

Partition ID is saved in appropriate entries of the Partition Table and takes only 1 byte of space. 

Partition Label (or Volume Label) is a small textual field (up to 11 characters) that is located in the partition's boot 

sector. This value is used for notification purposes only. It is detectable by any partitioning tool including the DOS FDISK 

utility. 

Modern operating systems save it within a file system, e.g. as a special hidden file. Thus it is able to contain a relatively 

large amount of text in multiple languages. 

Partitioning Scheme is a set of rules, constraints and format of the on-disk structures to keep information on partitions 

located on a hard disk. 

There are known several partitioning schemes. The most popular of them is the so-called DOS partitioning scheme. It 

was introduced by IBM and Microsoft to use multiple partitions in the disk subsystems on IBM PC compatible 

computers. 

Another popular partitioning scheme is the so-called Logical Disks Model (LDM) that originates from the UNIX 

mainframe systems. Veritas Executive accommodates a simplified version of LDM to the Windows 2000 operating 

system. 

Windows 2000 and XP support two quite different partitioning schemes: the old DOS partitioning scheme and the new 

Dynamic Disk Management (DDM). The problem is that earlier versions of Windows do not support DDM. In addition, 

most hard disk utilities do not support it as well. 

Recovery Media is a CD/DVD disc, a USB flash card or even a floppy disk from which you can boot for maintenance or 

recovery purposes. 

Root Directory is the top-level directory of a formatted logical drive to include other files and directories. In modern file 

systems (Ext2/Ext3, NTFS and even FAT32) it does not differ from other directories. This is not the case for old FAT12 

and FAT16 file systems. 

Serial Number. In the DOS partitioning scheme, every hard disk and every partition has a 32-bit serial number 

represented by an 8-figure hexadecimal value. It is stored in the MBR and its value is assigned when the MBR sector is 

initialized by Microsoft standard disk managing tools, such as Windows Disk Administrator and the FDISK utility. 

In fact, a hard disk's serial number is not important for most operating systems and software. It is known that Windows 

NT, 2000 and XP store its value in the database of assigned drive letters. 

A partition's serial number is stored in its boot sector (in FAT16, FAT32 and NFTS file systems). Its value is assigned when 

the partition is formatted. It does not play an important role for most operating systems and software as well. 


